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1 Purpose and Scope

This application note provides detailed information on adding “Over the Air (OTA) updates”
capability for user applications to be hosted in the MCU sub-system of CC3200 device.

Basic premise of the following reference is to help MCU application developers integrate the
reference OTA library with his application. Integrating the OTA service would enable in-system
upgrades of the MCU application, other vendor files and CC3200 Firmware releases made available
by Texas Instruments.

e Listing
e Content

/ !\\// 7\\// ’\
S \\\
—_— Internet L
loT Devices WiFi Hosting Service
(End Points) Gateway Viz. DropBox

<

CC3200 “Over The Air” (OTA) Update: Browse the “Listing” ; Download the “Content” and “Commit”

Figure 1 : CC3200 OTA: Basic Flow

These upgrades happen on the wireless network, and the library itself is oriented to scan the
vendor’s element listing on DropBox [A file hosting provider — more details in subsequent sections],
download / commit these elements to the CC3200 Serial FLASH.

How to use this Document:

This Application Note consists of five sections

e Overview: Developer can refer to this section to get a high level familiarity with OTA
enablers included in CC3200 version 1.1.
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Introduction to “ota_update” example: This section would introduce the reference
example included in the SDK package. This should help developers experience a few key
capabilities like “rollback” of Application Image

Adding OTA Service to an Existing Application: Developers can refer to this section for a
step by step procedure integrating OTA services with their existing application

Working with other File Hosting Services: As mentioned earlier the OTA solution is tuned to
operate with DropBox service. This section attempts to provide specific pointers to the MCU
application developers to modify OTA Library for inter-working with other hosting services.
A case study to support Exosite cloud service is also provided.

Detailed Flow / Transactions: Detailed ladder diagrams have been provided in an Appendix
for users who wish to understand the transactions better

So if you are looking to get started immediately to link OTA and FLC libraries with your existing
application, then jump to straightaway to Section-5.

For a better understanding of the OTA enablers and some key concepts viz. Commit/Rollback visit
Sections - 3.

Section-4 would come handy understand the example provided in SDK. This would be nice place to
experiment with features like application rollback

Section-6 would be useful reference, if you decided to use a different cloud service provider

2 References

Term Comments

SDK Refers to CC3200 Software Development Kit
http://www.ti.com/tool/cc3200sdk

Tl Refers to Firmware Package released by TI (pertains to updates associated with

Service WiFi and Networking Blocks)

Pack
http://www.ti.com/tool/cc3200sdk

OTA Over The Air Client - this refers to a sub-module in the OTA library that is

Client responsible for stabling the initial connection with the hosting server to check for
updates and the associated listing

CDN Content Delivery Network Client — this refers to a sub-module in the OTA

Client library that is responsible for actually Downloading the elements

CDN comes into picture after OTA Client receives the complete listing from the

Copyright © 2014, Texas Instruments Incorporated
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hosting server

FLC File Commit — this refers to a module in the OTA solution that gets invoked after
CDN does its Job. This module helps with basic checks on the new image and
allows either a “Commit” or a “roll back”

Commit | This is the action of the user applicationaccepting the update viathe FLC library
Rollback | This isthe action of the user application not accepting the update via the FLC
library and requesting a revert to previous (or Factory Default) application image
Uniflash | UniFlash the flashing tool that needs to be deployed for programming the
CC3200 SFLASH

http://processors.wiki.ti.com/index.php/CC31xx %26 CC32xx UniFlash Quick Start
Guide

CSP Cloud Service Provider (viz. DropBox)

SFLASH | Serial Flash connected to CC3200. CC3200’s File System resides in this storage

Copyright © 2014, Texas Instruments Incorporated PAGE: 5/58
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3 Overview of OTA Enablers

At a high level, the OTA enablers, when linked with the MCU application (and triggered):
e Connect with DropBox serviceand look for an update / Listing
e Download / Transfer the content to SFLASH connected to CC3200 device

e Provide a reference to check the MCU application and allow either to “Commit” or

“Roll back”
. o
MCU Application OTA Client CDN Client LG G
Boot loader
>> Normal >> Check for >> Download / .
. >> Activate new
Operation Updates Transfer new
content and test
Content
(OTA Services are >> Retrieve the .
Linked) element listing >> Commit or
Roll back
Trigger/Event viz.
Internal: Timer Expiry
External: Button Press
(GPIO Toggle Interrupt)

Figure 2 : Concept
In this section, we would have a quick look at the components and sum it all up with a high
level flow description

3.1 Components

OTA Enablers included in CC3200 SDK provide different services/ references and Figure —
3 attempts to capture there functionalities and utility.
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These enablers are:

OTA Library

File Commit Library

MCU Application Boot Loader (a.k.a. Secondary Boot Loader)
Reference Example

OTA Library (ota.a)

Location \cc3200-sdk\simplelink_extlib\ota

(in SDK

Distribution)

Source Available

Build IDE projects and pre-built libraries available

CCS - \cc3200-sdk\simplelink_extlib\ota\ccs\Release\ota.a

IAR- \cc3200-sdk\simplelink_extlib\ota\ewarm\Release\exe\ota.a

GCC - \cc3200-sdk\simplelink_extlib\ota\gcc\exe\ota.a

API \cc3200-sdk\doc\ CC3200 Simplelink OTA Extlib API User's Guide.chm
Description
Functionality | OTA Library can be splitin two components.

OTA Client is responsible for connecting to the hosting server/service and
specifically look for updates in folder specified with the MCU application. In
the event of the updates being available, the Listing is queried. OTA Client’s
communication with the hosting service should comply with the Hosting

service’s protocol and APIs (for example the reference in our package uses
DropBox API)

CDN Client is responsible for transferring the Content from the hosting
service and deploys a standard HTTP/REST flow.
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File Commit Library (flc.a)

Location \cc3200-sdk\simplelink_extlib\flc

(in SDK

Distribution)

Source Available

Build IDE projects and pre-built libraries available

CCS - \cc3200-sdk\simplelink_extlib\flc\ccs\Release\flc.a

IAR- \cc3200-sdk\simplelink_extlib\flc\ewarm\Release\exe\flc.a

GCC - \cc3200-sdk\simplelink_extlib\flc\gcc\exe\flc.a

API \cc3200-sdk\doc\ CC3200 Simplelink OTA Extlib API User's Guide.chm
Description
Functionality | FLC provide services for:

- Accesses to the SFLASH file system (Open, Read, Write, Close)
- Managing the MCU image commit process:
o Uses /sys/mcubootinfo.bin file to identify active image (1, 2)
and image status (TESTING, TESTREADY, NOTEST).
o Selects the image (file in SFLASH) that needs to be updated
with the content that CDN transfers
o Allows testing/evaluation the new image by setting
TESTREADY and signaling reboot.
o Commits the new image when indicated by host application.

MCU Application [a.k.a. Secondary] Boot Loader (application_bootloader.bin)

Location \cc3200-sdk\example\application_bootloader
(in SDK

Distribution)

Source Available

Build IDE projects and pre-built images available

CCS - \cc3200-sdk\example\application_bootloader\ccs\Release\

IAR- \cc3200-sdk\example\application_bootloader\ewarm\Release\Exe\
GCC - \cc3200-sdk\example\application_bootloader\gcc\exe\

API NA

Description
Functionality | Let us start with an understanding of why we need this component.

MCU’s Primary Boot Loader executes from the ROM (hence cannot be
modified) and loads user’s application image residing in Serial FLASH to the
MCU’s ROM and transfers the execution control.

User’s Image in the TI FileSystem (SFLASH) is tagged as
“/sys/mcuimg.bin”. So if we were not concerned about OTA, this would
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specifically be the user image.

For OTA, we require two stage boot loading. So the MCU’s Primary boot
loader would load /sys/mcuimg.bin which would be MCU’s Secondary boot
loader.

Given the above, the Secondary Boot Loader could be used as an effective
tool to load and execute binary images from the SFLASH storage after
making a choice from multiple binary images available in the storage. This is
the key for providing a back-up mechanism for the MCU application images
(something that could enable a rollback, if the new update with OTA has a
problem)

Note: Application Boot Loader provided in the SDK is an example with
capabilities/Functionality listed below. Source code is made availablein the
SDK in case the developer wishes to alter the behavior.

Focus of this specific example is to enable the developer to create a roll-back
option. Specifically this implementation can manage three user images and
would be responsible for selecting one of the following three application
images

Remember /sys/mcuimg.bin would be the secondary boot loader itself and
needs to flashed in the SFLASH at production.

/sys/mcuimgl.bin | Factory Default (This is something that would flashed
in the system during the production flow for the end
equipment)

/sys/mcuimg2.bin | Application Image (Updated)

/sys/mcuimg3.bin | Application Image (Updated)

Key points:

e The secondary boot-loader on execution will auto relocate to the
SRAM base area “0x20000000 to 0x20003FFF” before loading the
application images; this ensures that actual application can still start
at 0x20004000.

e Application boot loader loads application images from SFLASH
using simple link NVMEM API’s.

e Application boot loader refers to the boot info file
(/sys/mcubootinfo.bin) to keep track of the latest and best known
image, see “Application image selection and rollback logic” section
for more details.
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e If the bootinfo file doesn’t exists in the file system it is auto generated
by application bootloader by scanning the file system for bootable
images in the following order, if none exists, the booting is aborted:

1. Factory Default i.e. /sys/mcuimgl.bin
2. App Image 1 i.e. /sys/mcuimg2.bin
3. App Image 2 i.e. /sys/mcuimg3.bin

e Application Boot Loader image is a concatenation of two binaries
(termed as re-locator and boot manager)

Boot

e 16 KBytes

Re-locator f256 Bytes

Source Files briefly explained

® main.c : Contains the core logic for application bootloader

e startup_*.c : Start up file for respective IDEs

e udma_if.c : UDMA driver wrapper APl implementation
Usage

This application can be compiled using CCS and IAR. Project files are
provides for each in their directories.

This application uses an “Optimized” version of the “simplelink” library.
The following section list the steps for compiling this application

IAR
1. Open the simplelink work space from cc3200-

sdk\simplelink\ewarm\simplelink.eww

2. From the workspace select NON_OS project configuration

Copyright © 2014, Texas Instruments Incorporated PAGE: 10/58
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ccs
GCC

Go to project->Options->C/C++ Compiler->Optimizations->Level and set it
to “Medium”

Go to project->options->Library Builder and make sure the output file
name is changed to simplelink_opt.a”.

Build the project configuration.

Open cc3200-sdk\example\application_bootloader\ewarm\bootmgr.eww
Rebuild the project. This will generate
application_bootloader\ewarm\application_bootloader.bin

Import thesimplelink project to CCS workspace

Right click the project. Go to Build Configurations->Set Active. Select
NON_OS.

Right click the project->Properties. Go to CCS build->ARM Compiler-
>Optimization. Set optimization level to “3 Interprocedure
Optimizations”

Go to CCS build->ARM Archiver->Basic Options. Set output file name
to “S{ProjName} opt.a”

Rebuild the project

Import “bootmgr” from cc3200-
sdk\example\application_bootloader\ccs

Rebuild the project.

Execute the below command on Cygwin in the simplelink/gcc
make -f Makefile_opt target=NONQOS

See Section-4 section for details to use this bootloaderalong with

OTA Application.

Reference Example — “ota_update”

Location \cc3200-sdk\example\ota_update

(in SDK

Distribution)

Source Available

Build IDE projects and pre-built libraries available
API NA

Copyright © 2014, Texas Instruments Incorporated
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Description

Functionality | Please Refer to Section#4

3.2 Summing it all

Before we summarize the high level flow let us once review the process of setting the content
with the CSP (with DropBox in this reference)

3.2.1 Creating the DropBox API Application

e Createa Dropboxaccountand login
e Go to https://www.dropbox.com/developers/apps/create and choose “Dropbox API

App
e Choose “Files and DataStores” and “Yes my app only needs access to files it creates”

4

e Providea nameforthe App and click “Create APP” button

e You'll beredirected to App settings page. Scroll down to “Generate access token”
and click generate. Copy and save the generated token. Please note that this “access
token” is absolutely critical for the embedded application to communicate with
DropBox service.

e Go to https://www.dropbox.com/home/Apps

o Clickonthe applicationname

e Createa new folderand give it some meaningful name. This name will be used to
identify the CC3200 application version and must be less than 20 characters.
The nameshould includevendorid, productid and the SW version.
for example: “TI_CC3200_WTHRO1"

3.2.2 Nomenclature of the files to be hosted on DropBox

Please note that rules specifically related to file nomenclature are quite important as the
listing of the files is the only cue the OTA client has regarding the further procedure

The folder nomenclature as mentioned earlieris quite flexible and developer can exercise
his discretion. In the followingthe folder nomenclature is extracted from the reference

example we have in the SDK but again to reiterate, the file nomenclatureisratherrigid

The files stored on the cloud should be in the following format

Copyright © 2014, Texas Instruments Incorporated PAGE: 12/58
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| /VidVV_PidPP_VerRRXX/fAA_sys_filename.ext |

The directory or folder /VidVV_PidPP_VerRRXX

Note: Thisis as per our example; developer can choose the name aslongas it does not
exceed 20 characters

e VidVV - Vendorid number
e PidPP — Productid number
e RR — Applicationversion
o XX — Service Pack version

The filename fAA_sys_filename.ext

Note: This scheme is exploited by OTA Client, developeris expected to name his filesin the
cloud accordingly

e fAA - FileFlags

o f -File prefix
e AA -Fileflags bitmap:

o 01-Thefileissecured
02 - Thefile is secured with signature
04 - The file is secured with certificate
08 - Don't convert _sys_into /sys/ for SFLASH
10 - Use external storage instead of SFLASH
20 - Reserved.
40 - NWP should bereset after this download
80 - MCU should be reset after this download

0O O O 0O O O O

e sys -Interpretedasthe folderinTlI's embedded filesystem (hosted in Serial Flash).
So thistag would be converted to /sys/ directory in TI’s SFLASH (embedded) file

system
o ext
o signature - .sig, filename must be the name of the secured file
o certificate - .cer, filename must be the name of the secured file
Example:

- Vid01_Pid33_Ver18/f43_sys_servicepack.ucf is TI’s device firmware service pack for
vendor id 01, product id 33, version 18 and secured file /sys/servicepack.ucf
- Vid01_Pid33_Ver18/f80_sys_mcuimgA.bin is developer’s MCU image

righ 2014, Texas Instruments Incorpor.
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3.2.3 High Level Flow

1
Cloud (DropBox in the example) Content Placed In Cloud
Service Updates by Vendor

L Content
Provider [Listing

6]

Standa HTTP/REST

Tl Firmware Update
Vendor’s MCU
Application Update

f43_sys_servicepack.ucf

f80_sys_mcuimgA.bin

CSP Proprietary APIs,

L]
L}
[} L
[} L]
_ I
— Internet = '
"\~\77777 . I g L] L]
e ———— L] L}
L} [}
L] L]
L} L]
CC3200 : : Serial FLASH
] [} L}
Network Processor & WiFi : : Tl File System
| Lo
L] L} >
SimpleLink Libra [ /sys
Networking / FileSystem (SFLASH) APIs '
- — Rollback/Commit
"o /mcubootinfo.bin | <@ poference
L} L]
flc.a ]
. ) — Application
f I M ' A o 4—
i12_suninii dp ! /mcuimg.bin Boot loader
v t o —
. . ] e R MCU App Image
OTA Client CDN Client N gL (Factory Default)
L] L}
@ E ] : MCU App Image
t t + L-dp|/mcuimg2.bin < (First Update)
- OTA Application ! —— )
OTA Library__(Wrapper) ' /mcuimg3.bin Bl g M€Y App Image
@ s [FSLLLLLLLEVILINY (Next Upgrade)
L} >
' 3 /servicepack.ucf Tl Firmware
User Application | | T=7°°° Service Pack
MCU [CM4] MCU Primary Boot loader (ROM)

Figure 3 : High Level Flow
We have seen earlier the pointers to get the CSP account up and getting the content set up

2. User application invokes the OTA process on an event for example periodically on expiry of a
timer or aninterrupt tied to a GPIO transition where in the GPIO gets associated with a
physically button on the end equipment or the board

3. OTA client send “update_check” request with vendor id , ask OTA server for a list of
resources
OTA Server based vendor id sends back the list to resources to update

5. OTA client send “metadata” request with next resource id, asking for specific resource
information
OTA server sends back the CDN domain and path to the resource
OTA app call CDN Client to download the resource to the File system (or to external storage)
CDN client, using HTTP requests, downloads the file in chunks into the File storage
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9. Steps from 4 to 8 are repeated until each resource in the list is updated.
10. OTA returns DOWNLOAD_DONE to user application along with reset MCU and/or NWP flag.

11. User application activates the commit process.

3.2.4 Application Image Selection and Rollback Logic

Let us start with a description of relevant files in Tl FileSystem (hosted in SFLASH) from the
OTA perspective.

“[sys/mcuimg.bin”

This file would host the Application Boot Loader [a.k.a. MCU’s Secondary boot loader]. This
file should be flashed at production. Remember that MCU’s ROM (Primary) Boot loader
recognizes only thisfile and for OTA services this file would host the image correspondingto
the secondary bootloaderin order to manage/load the followingfiles

“/sys/mcuimgl.bin”

This file would host the baseline Factory default user application image. This file should be
flashed at production. In our example, we are propagatingthe notion where thisimage
would always be retained in the file system and could supersede any further updates via
OTA, if they do not perform to the desired expectation.

“[sys/mcuimg2.bin” and “/sys/mcuimg3.bin”

Now these are images which would be transferred in-system via OTA. Purpose of having
two of these is to support a “rollback” feature

"/sys/mcubootinfo.bin”

Thisfileis updated by the FLC library and is referred to by the MCU’s Application
(secondary) boot loader to implement commit/rollback feature. If thisfile is flashed during
production then the application bootloader generates this file on the first power up cycle
based on the followingrules

If the mcubootinfo.bin file doesn’t exists on the file system it is auto generated by this
bootloader by scanningthe file system for bootableimagesin the followingorder, if none
exists, the bootingis aborted:
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e Factory Default - /sys/mcuimgl.bin
e App Image 1 - /sys/mcuimg2.bin
e App Image 2 - /sys/mcuimg3.bin

If user wants to use all the three images, then flash the first application binary as
/sys/mcuimgl.bin. In case user wants to use only 2 images (no Factory default) then flash the first
application binary as /sys/mcuimg2.bin. Note that if there exists an old /sys/mcubootinfo.bin file
and you want to start a fresh with a new image programming via Uniflash, make sure to delete the
/sys/mcubootinfo.bin file.

Rollback

This file has the following info

Table 1 : Application image selection and rollback logic

File name of current active image, This can have the values
ACTIVE_IMAGE_FILE_NAME 0 - /sys/mcuimgl.bin — Factory default image
(sBootlInfo_t.ucActivelmg) 1 - /sys/mcuimg2.bin

2 - /sys/mcuimg3.bin

Status of the OTAU image
OTAU_MCU_IMAGE_STATE OxABCDDCBA - IMG_STATUS_NOTEST
(sBootInfo_t.ullmgStatus) 0x56788765 - IMG_STATUS_TESTREADY

0x12344321 - IMG_STATUS_TESTING

If this file does not exit, the application bootloader creates it based on following priority order:

If /sys/mcuimgl.bin exists, active image is set to this else
If /sys/mcuimg2.bin exists, active image is set to this else
If /sys/mcuimg3.bin exists active image is set to this else

o 0o T o

Booting is aborted

1. Reads the parameter “ACTIVE_IMAGE_FILE_NAME” and “OTAU_MCU_IMAGE_STATE"
from this file /sys/mcubootinfo.bin.

2. If OTAU_MCU_IMAGE_STATE is equal to IMG_STATUS_NOTEST. Launch the contents of the
file “ACTIVE_IMAGE_FILE_NAME” for execution.

3. If OTAU_MCU_IMAGE_STATE is equal to IMG_STATUS_TESTING, It means image previously
tested has not been committed. Set the parameter “OTAU_MCU_IMAGE_STATE” to
“IMG_STATUS_NOTEST” and launch the contents of the file “ACTIVE_IMAGE_FILE_NAME”
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for execution. This step essentially ensures rollback to previous image in case of new image
test failure.

4. If OTAU_MCU_IMAGE_STATE is equal to IMG_STATUS_TESTREADY. Set the parameter
“OTAU_MCU_IMAGE_STATE” to “IMG_STATUS_TESTING” and launch the contents of the
file “NON_ACTIVE_IMAGE_FILE_NAME” for execution. ACTIVE_IMAGE_FILE_NAME and
NON_ACTIVE_IMAGE_FILE_NAME would share the below relationship

Table 2 : Active and In-Active Images

Active Image In Active Image
/sys/mcuimgl.bin /sys/mcuimg2.bin
/sys/mcuimg2.bin /sys/mcuimg3.bin
/sys/mcuimg3.bin /sys/mcuimg2.bin

righ 2014, Texas Instruments Incorpor.
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Evolution of Serial Flash Contents with Commit or Rollback — A few Scenarios

Serial FLASH Serial FLASH Serial FLASH Serial FLASH Serial FLASH
TI File System Tl File System Tl File System Tl File System Tl File System
> > > > >
/sys /sys /sys /sys /sys
o > > >
/mcubootinfo.bin /mcubootinfo.bin /mcubootinfo.bin /mcubootinfo.bin
> > >
/mcuimg.bin /mcuimg.bin /mcuimg.bin /mcuimg.bin /mcuimg.bin
@ANEE dEEER (EEER
/mcuimgl.bin i /mcuimgl.bi /mcuimgl.bin /mcuimgl.bin /mcuimgl.bin
tive ctive
/mcuimg2.binActive /mcuimg2.bin /mcuimg2.bin active
> dEEEp
/mcuimg3.bin . /mcuimg3.bin
AC1
> > >
/servicepack.ucf /servicepack.ucf /servicepack.ucf /servicepack.ucf /servicepack.ucf

Factory Default

Application Boot
Loader and Factory
Default User Image

After First Power
Cycle

mcubootinfo.bin
gets auto-created

After the first
successful update
and Commit

mcuimg2.bin

After the second
successful update
and Commit

mcuimg3.bin
becomes the Active

After the third
successful update
and Commit

mcuimg2.bin again
becomes the Active

image image image

Figure 4 : Flow of Successful Installation and Commit

Serial FLASH Serial FLASH Serial FLASH
Tl File System Tl File System Tl File System
> > >
/sys /sys /sys
> R
/mcubootinfo.bin /mcubootinfo.bin
> > >
/mcuimg.bin /mcuimg.bin /mcuimg.bin
> > @NEE
/mcuimgl.bin - Active /mcuimgl.bin- Active /mcuimgl.bin e
([T
/mcuimg2.bin
> > >
/servicepack.ucf /servicepack.ucf /servicepack.ucf

Factory Default

Application Boot
Loader and Factory
Default User Image

After First Power
Cycle

mcubootinfo.bin
gets auto-created

After the first un-
successful update
and Rollback
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Serial FLASH Serial FLASH Serial FLASH Serial FLASH
Tl File System Tl File System Tl File System Tl File System
> > > >
/sys /sys /sys /sys
@ > >
/mcubootinfo.bin /mcubootinfo.bin /mcubootinfo.bin
> > > >
/mcuimg.bin /mcuimg.bin /mcuimg.bin /mcuimg.bin
> > AN AN
/mcuimgl.bin -~ Active /mcuimgl.bin- Active /mcuimgl.bin /mcuimgl.bin
> >
/mcuimg2.binActive /mcuimg2.bin 2
AN
/mcuimg3.bin

/servicepack.ucf /servicepack.ucf /servicepack.ucf /servicepack.ucf

After First Power After the first After the second
Factory Default
Cycle successful update unsuccessful update

and Commit and Rollback

Application Boot . . mcuimg2.bin mcuimg2.bin

Loader and Factory mcubootinfo.bin . .
becomes the Active stays as the Active

Default User Image gets auto-created . .
image image

Figure 5 : Flow of un-Successful Installation and rollback

Note: At this point we would like to summarize a few points again
e User application (that gets downloaded or the factory default one as well) has the
responsibility of including an acceptability test/criteria (viz..Connectivity to a WiFi AP or Just

getting the timer interrupts etc..)

e Based on passing or failure of the above criteria, user application would use FLC API to select
(or rather point to) the intended image i.e.

o Commit to Newly downloaded one or
o Rollback to Previous Image or Factory Default.

e FLC Library translates the decision to “/sys/mcubootinfo.bin” in the Serial Flash FileSystem.

e Application (secondary) Boot Loader can pick the intended MCU application image based on
commit or rollback information stored by FLC library in /sys/mcubootinfo.bin

righ 2014, Texas Instruments Incorpor.
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4 Sample Application (Packaged with CC3200 SDK)

This application focuses on showcasing CC3200’s ability to receive firmware update and/or any
related files over the internet enabled Wi-Fi interface. The example uses Dropbox APl App platform
to store and distribute the OTA update files.

An APP on Dropbox API platform can be looked at as a network accessible drive where user
contents are arranged as a tree of files and/or folders. The OTA library expects a folder at the top
level which is pointed to via VendorString (the folder name on Dropbox), set during OTA
initialization. This top level folder should contain the files to be updated directly and no folders. The
OTA library also puts some restriction on the file names (see File Naming Convention for OTA on
Dropbox section). File(s) with other name pattern will be rejected.

The VendorString can be constructed in a variety of ways and as an example this application
constructs it by appending the Service Pack version to a macro OTA_VENDOR_STRING defined in
otaconfig.h file.

Assuming the current service pack running on the device holds the version number
2.1.0.87.31.0.0.4.1.1.5.3.3 and OTA_VENDOR_STRING is defined as Vid01_Pid00_Ver01, the
application constructs the VendorString by appending the 4t byte (shown in red) to the macro i.e.
Vid01_Pid00_Ver0187. This folder on Dropbox should contain all the files that need to be updated.
If left empty OTA library assumes a NO_UPDATE condition.

Note: For this example only 4™ byte of the service pack is used to build the folder name. To avoid
any case of 4™ byte repeating across versions, It is recommended to use all the bytes of the service
pack. Similar change needs to done in the example code.

Note: Application bootloader and the OTA library can be compiled with different flavor than the
default pre-build binaries. The configuration enables a more optimized and faster boot of the OTA
application. A detailed description on enabling the feature is provided as part Appendix section
8.3 at the end of the document

4.1 Source Files briefly explained

= NON-0S — Directory holding non-os based implementation of the application
e main.c - Contains the core logic for the application
e net.c - Wrapper function implementation for required SL_HOST APIs
e otaconfig.h - Contains OTA server configuration details
e pinmux.c - Auto generated file pin muxing on CC3200 LP boards
e task.c - Implements non-os tasking
= OS — Directory holding os based implementation of the application
e main.c - Contains the core logic for the application

Copyright © 2014, Texas Instruments Incorporated PAGE: 21/58

Features characteristic data and other information are subject to change.



H CC3200 SimpleLink™ Wi-Fi®
I$ TEXAS CC3200 Over-The-Air (OTA) Update Application Note
INSTRUMENTS
www.ti.com
e net.c - Wrapper function implementation for required SL_HOST APIs
e otaconfig.h - Contains OTA server configuration details
e pinmux.c - Auto generated file pin muxing on CC3200 LP boards
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4.2 Creating Dropbox APl application

Note: Assuming service pack version 2.1.0.87.31.0.0.4.1.1.5.3.3 is installed and next it is getting
updated to version 2.1.0.88.31.0.0.4.1.1.5.3.3

Create an account with Dropbox and login
Go to https://www.dropbox.com/developers/apps/create and choose “Dropbox API app”

Choose “Files and Datastores” and “Yes My app only needs access to files it creates”.

Provide a suitable name for the APP and click “Create APP” button

You will be redirected to Apps setting page. Scroll down to “Generated access token” and
click generate. Copy and save the generated token.

vk W e

Go to https://www.dropbox.com/home/Apps

Click on the application name
Create a new folder and name it “Vid01_Pid0OO_Ver0087”. This folder will contain only
Service pack of version 2.1.0.88.31.0.0.4.1.1.5.3.3

9. Create another folder and name it “Vid01l_Pid0O0_Ver0088”. This folder will contain
Application and other files corresponding to App version 01.

10. Create another folder and name it “Vid0O1_Pid00_Ver0188”. This folder will contain next
update. If no next update, leave the folder empty.

11. The rationale behind steps 8 to 10 is to ensure that Service pack gets updated first and then
other files like MCU image are updated. To start with device has Application files of version
00 and service pack of version 87. In order to update the device to Application files of
version 01 and service pack of version 88, copy new service pack 88 into the folder
“Vid01_Pid00_Ver0087” and all other application files corresponding to version 01 into the
folder “Vid01_Pid00_Ver0088”. After completion of the update Application will start to
point to “Vid01_Pid00_Ver0188”
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4.3 Configuring the application for new Dropbox account

Note: Assuming service pack version 2.1.0.87.31.0.0.4.1.1.5.3.3 is installed and next it is getting
updated to version 2.1.0.88.31.0.0.4.1.1.5.3.3

Open otaconfig.h
Update the following Parameters
a. OTA_SERVER_REST_HDR_VAL - Set this to the token generated in the previous

steps
b. OTA_VENDOR_STRING - Set this to Vid01_Pid00_Ver01
c. APP_VER_BUILD -1

3. Compile and upload the .bin file into “Vid01_Pid00_Ver0088” folder on Dropbox server
Rename it “f80_sys_mcuimgA.bin”.
5. Update the following parameters again
a. OTA_VENDOR_STRING - Set this to Vid01_Pid00_Ver00
b. APP_VER_BUILD -0

6. Open example\common\common.h, this file contains macros related to the network AP to
which this application will try to connect. Set the following parameters to match the AP

a. SSID_NAME - AP SSID Name
b. SECURITY_TYPE - Security type
c. SECURITY_KEY - Password, if any

Note: Parameters/macros defined in common.h file are shared among all the SDK examples.

Compile and upload the .bin file into “Vid01_Pid00_Ver0188” folder on Dropbox server
Rename it “f80_sys_mcuimgA.bin”.

4.4 Usage

4.4.1 Setting up OTA Application for LP with CC3200 SDK

4.4.1.1 Basic Setup

1. Copy simplelink_extLib directory into the root directory of the SDK, for example:
C:\ti\CC3200SDK\cc3200-sdk

2. Copy “ota_update” and “application_bootloader” directory into the examples directory,
for example: C:\ti\CC3200SDK\cc3200-sdk\example.

3. Create and setup Dropbox account (see sections below).
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4.4.1.2 Flashing

Open Uniflash tool for CC3xxx

Make sure LP is in UARTLOAD mode i.e. SOP2 jumper mounted.

Format the sFlash.

Program the service pack.

Go to File->New Configuration. Choose the connection and board and click ok
Set “/sys/mcuimg.bin” URL to point “application_bootloader.bin”

Select “Erase”, “Update” and “Verify”

® Nk wN e

Add a new file and rename it to “/sys/mcuimgl.bin”. If no factory default is required
rename it to “/sys/mcuimg2.bin”. Set the URL of this file to point to the OTA application
binary, set the URL of this file to point to the OTA application binary, say
“ota_update_nonos.bin” if using NON-OS example.

9. Select “Erase”, “Update” and “Verify” for this new file.

10. Set the COM port to LP’s com port number

11. Press Program

4.4.1.3 Running

Remove SOP2 jumper

Connect to COM port via Tera-term or Hyper Terminal with following configuration
a. Port: Enumerated COM port
b. Baud rate: 115200
c. Data: 8 bit
d. Parity: None
e. Stop:1 bit
f. Flow control: None

3. Press reset.
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4.4.2 Triggering OTA Update

1. Wait for the Application to completely boot. Observer the app version

U COMGE115200baud - Tera Term VT =B (i

File Edit Setup Contrel Window Help

SoE-aE-aE -0 e e JaE oo o030~ Jof e e ~nE -0 JoE oo~ JaE -~ e e e oo oot Jef-Jef e e Tef- oo

CC3288 OTA Update Application

o0 a0 a0 - Juf 30 oo~ - o Jof-uE-J0f-ef -0 -JeE- 0 o0 -Jef-30 -Jof -3 Jof -3 3o -uE e -Jof—Jnf-Jof—Jnf-Jof 3 -Jof 3 -Jof -3 -Jof-3uf-Jof -Jof-Jof -Jof-of-

pp Version
wp Uersion

1.8.8
2.8.7.8.31.8.8.4.1.1.5.3.3

ifi Status Connected to ccl2BBdemo

dmnzfA.la—archdiocesze_net
289 .151 .225.1688

Wed Sep 24 20814 B5:34:57
Wed Sep 24 2814 11:84:57

TP Server
TP Server IP

TH Time
ocal Time <(+@5:38>

ThA Update Status Press SUW3 : Updates or SWZ: Factory Heset

2. Press SW3 on LP to start the update. Observer the “OTA Update Status” is now “In Progress”

¥ COM68:115200baud - Tera Term VT — (= [ & |

File Edit Setup Control Window Help

3030303030 30 0 - J0E 303006~ 0E - 03030000 - 00000000000 000000 oo oo IE

CC3288 OTA Update Application

3030303030 30 0 - J0E 303006~ 0E - 03030000 - 00000000000 000000 oo oo IE

1.8.8
2.8.7.9.31.90.8.4.1.1.5.3.3

pp Version
wp Uersion

ifi Status Connected to cc328B8demo

dmzB.la—archdiocese . net
2@%.151 .225.188

Yed Sep 24 2614 B5:35:13
Wed Sep 24 2014 11:85:13

TP Server
TP Server IP

TH Time
ocal Time (+B5:38>

TA Update Status : In Progress...
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3. Wait for OTA to complete. Application will reboot itself

i COM68:115200baud - Tera Term VT = | B

Eile Edit Setup Control Window Help

000030 30 - J0E 303006~ 003030300 ~nE-mE- 0 -0 30 -0 -JoE 30~ ~30E 30 -0 - J0E-0E 06—~ J0E-J0E-Jof-Ief-eE e - J0-JoE-oE-E-

CC3288 OTA Update Application
Jof-of-JnE-Jo o ~3f-Jof ~nE- o -JoE ~oE- oo o -JuE e~ JnE-Jof ek~ JmE-Jof - InE-Juf-IeE-JmE-Jof e Juf-Jof ~nE-J0f-JoE~eE-Jof ~oE- o -Jof-ef-JE-Jef-ef-Juf~ef-IeE-Jef-eE-JuE-TeE-

1.8.8

App Uersion
2.8.7.8.31.8.8.4.1.1.5.3.3

Mup Uersion

ifi Status Connected to cclZ2BBdemo

dmz@.la—archdiocese.net
289 .151 .225.188

Yed Sep 24 2014 B5:35:43
Wed Sep 24 2614 11:85:43

TP Server
TP Server IP

M Time
ocal Time (+B5:38>

TA Update Status : Completed Rebooting. ..

4. Observer App version after reboot

i COM68:115200baud - Tera Term VT = | B

Eile Edit Setup Control Window Help

000030 30 - J0E 303006~ 003030300 ~nE-mE- 0 -0 30 -0 -JoE 30~ ~30E 30 -0 - J0E-0E 06—~ J0E-J0E-Jof-Ief-eE e - J0-JoE-oE-E-

CC3288 OTA Update Application
Jof-of-JnE-Jo o ~3f-Jof ~nE- o -JoE ~oE- oo o -JuE e~ JnE-Jof ek~ JmE-Jof - InE-Juf-IeE-JmE-Jof e Juf-Jof ~nE-J0f-JoE~eE-Jof ~oE- o -Jof-ef-JE-Jef-ef-Juf~ef-IeE-Jef-eE-JuE-TeE-

1.8.1

App UVersion
2.1.8.87.31.1.1.8.5.1.8.3.2@

Mup Uersion

ifi Status Connected to cclZ2BBdemo

dmz@.la—archdiocese.net
289 .151 .225 188

TP Server
TP Server IP

TH Time : Wed Sep 24 2814 85:36:43
ocal Time <+B5:38> : Wed Sep 24 2814 11:86:43
TA Update Status : Press SUW3 : Updates or SW2: Factory Reset

Note: Nwp version will be different from one show based on the service packs used.
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4.4.3 Sequence diagram

Application Dropbox
: Pointsto ;
App V00 Service Pack 87  |— _Vid01_Pid00_Ver0087 —> Service Pack 88
j ]
! |
: Points to :
. Vid01_Pid00_Ver0088
App VOO Service Pack88 |—— — — —— — — — > App V01
! |
; Points to :
. Vid01 _Pid00_Ver0188
App V01 Service Pack88 f— — —— — — — — —>

Figure 2: OTA Application Update Sequence

righ 2014, Texas Instruments Incorpor.
Copyright © 2014, Texas Instruments Incorporated PAGE 28/58
Features characteristic data and other information are subject to change.



H CC3200 SimpleLink™ Wi-Fi®

/3 TEXAS CC3200 Over-The-Air (OTA) Update Application Note
INSTRUMENTS
www.ti.com

5 Adding OTA Feature to Existing MCU Application — Reference

This section would be useful for developers who would like quickly add OTA feature to their
existingapplication. We have assumed that the baseline application uses TI’s Code

Composer Studio as development environment. Procedure is extendible to IAR as well.

Specifically here we have picked the GET_WEATHER applicationand illustrated the steps
one might have to follow to add OTA feature (GET_WEATHER is a sample application
available in CC3200SDK distribution - \cc3200-sdk\example\get_weather).

5.1 Creating DropBox API Application

Refer to section “3.2.1” — Do retain the “Access Token”

5.2 Getting CCS Settings in Order
*  Open CCS
* Importget_weather project
e Gotoproject properties\ ARM Linker\ File Search Path
* Addthe following pathsto thelibrary search path
1. "${CC3200_SDK_ROOT}/simplelink_extlib/ota/ccs/release”
2. "S{CC3200_SDK_ROOT}/simplelink_extlib/flc/ccs/release”
* Addthe followinglibrariesto the includelibraries:
1. “ota.a”
2. “flca”
* Gotoproject properties\ ARM Compiler\ Include Options
1. Addthe followingpathtothe include search path:
"${CC3200_SDK_ROOT}/simplelink_extlib/include"
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CET T S N =T
type filter text File Search Path [l v
1+ Resource
General
4 Build Configuration: |Release [ Active ] '] [Manage Configurﬂtions..‘]
i ARM Compiler
a ARM Linker
Basic Options = - - . - =
[File Search Path| Include library file or command file as input (--library, -1) g8 85
1> Advanced Opticns ‘libc.a”
ARM Hex Utility [Disabled] Z‘;’“{Z‘j'{)":'“
Debug free rtos.a
ota.a
< flc.a
Add <dir> to library search path (--search_path, -i) LR ==

"${CG_TOOL ROOTYIib"
"S{CG_TOOL_ROOTYinclude"
"§{CC3200_SDK_ROOT Y driverlib/ces/Release”
"§{CC3200_SDK_ROOTYsimplelink/ccs/05"
"§{CC3200 SO os”
C3200_SDK_ROOT}/simplelink_extlib/ota/ccs/relea
< "§{CC3200_SDK_ROOTY simplelink_extlib/flc/ces/release”

Reread libraries; resolve backward references (--reread_libs, -x)
["] Search libraries in priority order (--priority, -prierity)
[ Disable automatic RTS selection (--disable_auto_rts)

@ Show advanced settings [ OK ] l Cancel I

Figure 7: CCS Snapshot — Adding OTA / FLC libraries to existing MCU App

_ —
7 Propertics for get weathet D [ESEER
type filter text Include Options STy

> Resource
General
4+ Build Configuration: |Release [ Active ] = [Manage Configurations...|

4 ARM Compiler
Processor Options
Optimization
Include Options Add dir to #include search path (--include_path, -} € & 8§l 2
MISRA-C:2004 "${CG_TOOL_ROQT}include"

"§{CC3200_5DK_ROOTY example/common”

» Advanced Options "$4CC3200 SDK_ROOT Y driverlib”

> ARMLinker "4{CC3200_SDK_ROOTYinc"
ARM Hex Utility [Disabled] "${CC3200 SDK_ROOT}simplelink/”
Debug "§{CC3200_5DK_ROOTY simplelink/include”

"§{CC3200_SDK_ROOTY simplelink/source”
"§{CC3200_5DK_ROOT} oslib/”

"$4CC3200_SDK_ROOT}/simplelink_extlib/include”

Specify a preinclude file (--preinclude) =R AR=RARG

@ Show advanced settings I OK ] [ Cancel

Figure 8: CCS Snapshot — Adding the “Include” Folder
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5.3 Adding/ Linking OTA Components with GET_WEATHER Application

* In CCS, open main.c (of “get_weather”) and make the updates based on the

followingtable (a zip file is embedded in the document as well enable copy and

paste of the following statements - The zip file extracts 8 files with segmentsto be
added into the code)

¥
4

Edits_for OTA.zip

he media directly

Include I#incl'.:lde "flc _api.h"
#include "ota_api.h"
Section
$define OTA_SERVER NAME "api.dropbox.comn™
GIObaI/ #define OTA SERVER_IP ADDRESS 0x00000000
Define #define OTA SERVER SECURED 1
$define OTR_SERVER_REST_UPDATE_CHE "/l/metadata/auta/" // returns files/folder list
. #define OTA SERVER REST RSRC METADATA media/aucao” returns & url that serves tl
section $define OTA SERVER REST HDR "Authorization: Bearer "
$define OTR_SERVER_REST_HDR VAL "caccess token>"
#define LOG_SERVER NAME opbox. com™
#define OTA SERVER REST FILES PUT uto/"
#define OTA_VENDOR STRING
static OtalptServerInfo_t g_otaCptServerInfo;
static woid *pvOtalpp:
Function int OTAServerInfoSet (void **pvltalpp, char *vendorStr):
static wolid RebootMCU() :
Prototype
S
Local To be added to GetWeatherTask() function
Variables
hong OptionLen;
unsigned char CptionVal;
int SetCommitInt;
unsigned char ucVendorStr[20]:
OTA To be added to GetWeatherTask() function after
Initializati | GPIO_IF_LedOn(MCU_GREEN_LED_GPIO) function call
on
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f Initialize COT&

pvOtakpp = s1_extlLib Otalnit (RUN MODE NONE OS | RUN MODE BLOCKING,O) ;

strcpy | (char *)ucVendorStr,OTAR VENDOR STRING);

CTAServerInfoSet (&pvOtalpp, (char *)ucVendorS5tr):

OTA main | To be added to GetWeatherTask() function after
construct | IRetVal= Network IF_GetHostIP((char*)g ServerAddress,
/logic &ulDestinationlP);

Check if this image is booted in test mode

sl extLib OtaGet (pvOtalpp,EXTLIE OTA GET COPT_ IS PENDING CCMMIT, &OptionLen,
(_ug *)&CptionVal);

UART PRINT ("EXTLIB OTR GET COPT IS PENDING COMMIT? %d ‘n\r",OptionVal);
if (CptionVal == true)
UART PRINT ("OTA: PENDING CCMIT & WLAN O ==»> PFERFCRM CCMMIT ‘n\r"):

SetCommitInt = OTA ACTION TMAGE COMMITED:
sl _extLib OtaSet (pvOtalApp, EXTLIE OTA SET COPT_ IMAGE COMMIT,
gizeof (int), (_uf *)&SecCommitInt);
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else
- UART PRINT ("Starting OTA
1RetVal = 0;
while (!1RetVal)
- 1RetVal = =21 extlLib OtaRun(pvOtalkpp)
UART PRINT ("OTA run = %d ", 1lRetVal):
if ( 1RetWal < 0 )
- UART_FRINT ("CTRh:
;lse if | 1RetVal ==
- UART PRINT ("CTA: RUN_STAT NC UPDRT
;lse if {(lRetVal & RUN_ STAT DOWNLOAD DONE)
- S5et OTA File for testing
1RetVal = s1_extLib _Ota3Set (pvOtalpp, EXTLIE_OTA_SET_OPT_IMAGE_TEST,
sizeof(int), (_w8 *)&SerCommitInt);
UART PRINT ("OTA: NEW IMRGE DOWNLOAD CCMFPLE
UART_PRINT[”Rebcct;:g...1 A% S
RebootMCU() ;
Banner Replace “DisplayBanner(APP_NAME);” with the new code

Display

IDi splayBanner (OTA VENDOR STRING) ;

New
Functions

Added atthe end of “main.c”

int CTAServerInfoSet (void **pvOtalpp, char *vendorStr)

unsigned char machddressLen = 5L _MAC ADDR LEN;

f/ Set OTA server info

g_ota0ptServerInfo.ip address = OTA_SERVER IP ADDRESS;

g_otaOptServerInfo.secured connection = OTA_SERVER SECURED;

strcpy( (char *)g otalOptServerInfo.server domain, OTR_SERVER NAME);

strcpy( (char *)g otalCptServerInfo.rest update chk, OTA_SERVER REST UPDATE CHE]);
strcpy( (char *)g otalOptServerInfo.rest_rsrc metadata, OTA_SERVER REST RSRC METADATA);
strcpy( (char *)g otaOptServerInfo.rest_hdr, OTA SERVER REST HDR);

strepy( (char *)g_otalptServerInfo.rest hdr wval, OTA SERVER REST HDR VAL);

strcpy( (char *)g otalOptServerInfo.log server name, LOG_SERVER NAME);

strcpy( (char *)g otalOptServerInfo.rest_files put, OTA SERVER REST FILES PUT);

=21 NetCfgGet (5L_MAC ADDRESS GEI, NULL, &machddresslen, (_uf *)g_otaOptServerInfo.log mac address);

// Set OIA server Info
51 _extLib CtaSet (*pvOtahpp, EXTLIB OTA SET OPT SERVER INFO,
sizeof (g_otalOptServerInfo), (_uf *)&g_otalptierverInfo);

f/ Set wvendor ID.
=l _extlib OtaSet (*pvOtafpp, EXTLIB OTA SET OPT_VENDOR ID, strlen(vendor3tr),
(_u8 *)vendorstr);

// Return ok status
recurn RUN_STAT OK;
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static void RebootMCU()
f/{ Configure hibernate RIC wakeup

'/ Delay loop
MRP UtilsDelay(£000000);

f/ Set wake up time
PRCMHibernateIntervalSet (330);

{/{ Request hibernate
PRCMHibernateEnter () ;

f/ Conmtrol should never reach here

while (1)

Reboot the MCU by requesting hibernate for a short duration

PRCMHibernateWakeupSourceEnable (FRCHM HIE SLOW_CLE CIR);

* Set OTA_VENDOR_STRING with the name of your Dropbox library/folder

E.g: “TI_CC3200_WTHRO1"

* Set OTA_SERVER_REST_HDR_VAL with the dropbox token you have received when

creating the dropbox API
* Rebuildthe “get_weather” project

5.4 Configuring the default SFLASH contents

MCU Application (Secondary) Boot Loader

* Make sure SOP2 jumper is mounted (Setto ‘1’)
* Open CC3200 uniflash

* Press “new target configuration” and then “ok”
e Setthe CC3200 port number

* Choose/sys/mcuimage.bin
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* Setthe urlfield to: C:\ti\CC3200SDK_1.0.0\cc3200-
sdk\example\application_bootloader\ccs\Release\application_bootloader.bin

e Checkthe Erase, Update, Verify boxes

fsys/meuimgl.bin
fsys/mcuimg2.bin

B Consle £2

MaxSize 0

/| Erase

s CCS UniFlash - New Configuration (unsaved*) \ =Tren X
File Operation Window Help
Type your filter text here... /sys/meuimg.bin
4 CC31x Flash Setup and Control -
fsys/mcuimg.bin i
fcert/ca.pem
feert/client.pem
feert/privatekey Name | /sys/mcuimg.bin
/tmp/pac.bin
Jeys/macadd.bin Url CAHNCC32005DK_10.0\ce3200-sdk\example\application_bootloader\ccs\Release\application_bootloader.bin Browse

Figure 9: Uniflash Snapshot — Programming Application Bootloader

MCU Application Image(s)

* Choose Add file (on Uniflash session)

* Changethe new file nameto “/sys/mcuimgl.bin”

e Setthefile urlto “get_weather.bin”

(out come of ourlast build, located under the workspace folder and not under the

SDK, For example: C:\Users\youname\workspace_v6_0\get weather\Release)

Check the Erase, Update, Verify boxes

* Set the MaxSize to the maximum size you wish to reserve for your application

* Choose Add file

* Changethe new file nameto “sys/mcuimg2.bin”

* Repeaton thesettingof the previousfile

So now we have the Factory Default programmed (/sys/mcuimgl.bin) and we have also

flashed the same as the back-up image (/sys/mcuimg2.bin)
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<2 CCS UniFlash - New Configuration (unsaved®) - — [E=REER =
File Operation Window Help
Type your filter text here... /sys/meuimgl.bin |«
4 CC31x Flash Setup and Control
/sys/mecuimg.bin
fcert/ca.pem =
Jeert/client.pem — - -
feert/privatekey Name /sys/mcuimgl.bin
Jtmp/pac.bin B
/sys/macadd.bin Url  C\Users\a038765% workspace_v6_0_1\get_weather\Release\get_weather.bin
/sys/mcuimgl.bin
/sys/mcuimgd.bin \ MaxSize 0
[¥] Erase
[¥] Update
[V] Verify
Mede i
| 1 | »
&l console &2 51 Eﬁl ) ~[g~=0

Clear Console

Figure 10: Uniflash Snapshot — Programming Factory Default

Programming

* Go backto the main Uniflash screen

* Press Format

*  Press Choose Service pack update and browse for “servicepack_1.0.0.1.2.bin”

* Press “Program”

* Note: Please follow the instructions in the console menu, directing you to reset the
CC3200 LP from time to time

* Note
1. Once finished with uniflash programming, Remove SOP2 jumper
2. Connecta UART terminalto the LP COM port, set baudrateto 115200
3. Restartthe LP, by pressingthe SW1 switch
4. Connecttoa WLAN networkand see thatit istrying to check for updates
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5.5 Uploading the new Image to Cloud

A ¥ TEXAS_CCI200_WEATHEFR x fahrenheit to celsius - Gor % ¥ $% Create app - Dropbox LA W
&« C # |8 Dropboyx, Inc [US]| https://www.dropbox.com/home/Apps/SimpleLink%200TA/TEXAS_CC3200_WEATHERO1 7L =

pgrade account alon srednizk

Folder name with the
© original’Application Version

[ Rename complete. Undo

Q > TEXAS_CC3200_WEATHERO1

Files

le__l e f80_sys_mecuimga.bin file . 2hrsago
(# Sharing \ Blnary Image Of the new

Links version (after changing the
name)

Help  Privacy

Figure 11: DropBox Snapshot — Getting the content uploaded

e Change OTA_VENDOR_STRING to anew version then used before
* E.G: Originalname: “TI_CC3200_WTHRO01"
New name: “TI_CC3200_WTHR02"
e Buildthe project
e Draganddropthe new binarytothe Dropboxapp folder
e Renamethe file nameto “f80_sys_mcuimgA.bin”
e Restartthe LP, and connect to a WLAN network

6 Moving to other File Hosting Services

6.1 Porting OTA Library to other servers

Updating the TI’s CC3x00 OTA library to work with different hosting services would require
adapting transactions to the protocol requirements of the specific hosting service for accessing
content.

The library focuses on providing implementation for OTA using Dropbox server. Users
requiring to port this libraryto a different server will have to, but not limited to, re-
implement following low level APIs.

righ 2014, Texas Instruments Incorpor.
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1. OtaClient_UpdateCheck:

This function is expected to get list and number of updates from the OTA server and store it
in the internal data structure pOtaClient->pOtaCheckUpdateResponse->rsrcList. This array holds the
absolute path name and size of each file on the server.

This function is responsible for generating HTTP request packet, sending it over to the server
and parsing out the required details

For e.g. to get the list of file from the Dropbox server under Vid01 Pid00_Ver0l
folder the required HTTP request will be:

GET https://api.dropbox.com/1/metadata/auto/Vid01_Pid00_Ver01
Authorization: Bearer <access_key>

And the response

{"hash": "6f01f3a9e21da382bd3f9b6eee57fa2c", "rev": "96826f56f0b™,
"thumb_exists": false, "path™: "/Vid01_Pid00_Ver01","is_dir":true,
"contents": [{"rev": "97d26f56f0b™, "thumb_exists": false, "path™:
"/Vid01_Pid00_Ver01/f80_sys_mcuimgA.bin","is_dir":false,
"client_mtime": "Tue, 09 Sep 2014 12:29:44 +0000", "icon™: "page_white",
"bytes": 51812, "modified": "Tue, 09 Sep 2014 12:29:44 +0000", "size":
"50.6 KB", "root": "app_folder™, "mime_type": "application/octet-stream",
"revision": 2429}], "icon": "folder™, "bytes": 0, "modified": "Tue, 09 Sep
2014 12:00:05 +0000", "size": "0 bytes", "root™: "app_folder™, "revision™:
2408}

2. OtaClient_ResourceMetadata

This function is responsible for following:
a. Get the path of the resource on the CDN server
b. Extracting the file name of the resource removing the prefixes and flags. This would
be the name with which the file will be stored on local storage (sFlash)
c. Extract the flags from the resource name

This function is responsible for generating the HTTP request packet, sending and parsing the
response received

For e.g. to get the absolute path of a resource (/Vid01_Pid00_Ver01/f80_sys_mcuimg.bin)
from Dropbox the HTTP request will be
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GET https://api.dropbox.com/1/media/auto/Vid01_Pid00_Ver01/f80_sys mcuimgA.bin
Authorization: Bearer <access_key>

And the response:

{"url":

"https://dl.dropboxusercontent.com/1/view/19y6u9ma456k9p5/Apps/HELLO _WORLD O
TA/Vid01_Pid00 Ver01/f80 sys mcuimgA.bin", "expires": "Fri, 09 Jan 2015 14:10:01
+0000"}

Where
1. https://dl.dropboxusercontent.com/1/view/19y6u9ma456k9p5/Apps/HELLO_WORLD
OTA/Vid01_Pid00 Ver01/f80 sys mcuimgA.bin is the path of the resource on the
CDN,
2. _sys_mcuimg.bin converted to /sys/mcuimg.bin is the resource file name for storage
3. {80 if the flag. F if prefix and should be ignored.

For extracting file name and flags refer to OtaClient_ResourceNameConvert()
implementation for Dropbox.

3. CdnClient_ConnectByUrl

This function is responsible for connecting to the CDN serve, initiating the download of the
resource file and skipping any header. No file data is read by this API.

For e.g. for the resource
https://dl.dropboxusercontent.com/1/view/19y6u9ma456k9p5/Apps/HELLO WORLD OT
A/Vid01 Pid00 Ver01/f80 sys mcuimgA.bin. Here https://dl.dropboxusercontent.com is
the CDN domain name to which the connection is to be made and
/1/view/19y6u9ma456k9p5/Apps/HELLO_WORLD_OTA/Vid01_Pid00_Ver01/f80_sys_mcu
imgA.bin is the resource on this server.

6.1.1 Server Info Structure

This structure holds the server related parameter like the domain name, authorization key,
REST APIs, log server and vendor string. Following member variables are required to be initialized
and passed to OTA Library as part of initialization.

Depending on the end server to which this library is being ported, some of the parameters
might be obsolete or user might have to add more parameters/elements.

server_domain: This holds the server name for the OTA server.
Eg: api.dropbox.com for Dropbox REST APIs
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secured_connection: This holds if the connection to the OTA server and CDN server is secure or
non-secure.

rest_update_chk: This defines the REST API for getting the list of resources from the server
Eg: /1/metadata/auto/

rest_rsrc_metadata: This defines the API for getting the details of each resource on the server
Eg: /1/media/auto

rest_hdr: This holds the additional HTTP headers (like authorization) forthe server
Eg: Authorization: Bearer

rest_hdr_val: Holds the header value, like the access key.
Eg: BwPuaYu9AoAAABBBAAAAA-uhCfuTU_Jw540BVgBCtZaMAsDfhTZcV8ILK7ruzD51r

log_server_name: Server name for logging the OTA logs
Eg: api-content.dropbox.com

rest_files_put: This holds the REST API for writing to the server
Eg: /1/files_put/auto/

log_mac_address: MAC address of the current device using the OTA library. This is used for logging

6.2 Porting OTA Library and example to exosite server

The below description assumes that you have familiarized with file hosting capabilities
and format of the exosite server. Contact exosite for any queries or further details.

By defaultthe OTA library and example which is part of SDK works with the dropbox
server. In order to use OTA library and example with exosite below changes need to be
done.

1. File: example\ota_update\*\otaconfig.h. Below OTA server specific parameters
highlighted in red need to be changed. The parameter values mentioned below are
specifically for one of the example file that was hosted on the exosite server. Values
for parameters “OTA_SERVER_NAME”, “OTA_SERVER_REST_RSRC_METADATA"” and
“OTA_VENDOR_STRING” should match your exosite configuration.

define OTA_SERVER_NAME "texasinstruments.m2.exosite.com” I
define OTA_SERVER IP ADDRESS f

#define OTA SERVER SECURED 1

tdefine OTA_SERVER_REST_UPDATE_CHK "/provision/download?” // returns files/folder 1list

define OTA SERVER_REST_RSRC_METADATA  "/provisien/downlead?vendor=texasinstrumentsfmodel=cc3200lp vi&info=truelid=",
tdefine OTA_SERVER_REST_HDR "X-Exosite-CIK:"

fidefine OTA SERVER REST HDR VAL "TBD X-Exosite-CIK: value"

#define LOG_SERVER_NAME "api-content.dropbox. com”

#define OTA SERVER REST FILES PUT "fiffiles put/auto/”

Bdefine OTA VENDOR STRING "vendor=texasinstrumentsimodel-cc32eelp v1" |
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2. File:simplelink_extlib\include\ota_api.h. Below defines highlightedin red need to

be changed so as to accommodate info from exosite server.
define MAX_SERVER_NAME 32458
define MAX_PATH_PREFIX 43+58
define MAX_REST HDRS SIZE 9G+50
etine MAX_| | .
#define MAX USER PASS STR 3
etine MAX_CERT_S5TR 32458
define MAX_KEY_STR 32450

3. File: simplelink_extlib\include\ota_api.h. To the structure OtaFileMetadata_t add
the parameters cdn_hdrand cdn_hdr_val as below. For every access to exosite
server “access key” needsto be provided. The below additional parameters are for
that.

;;typedeF struct

ae {

91 /* files server name */
92 ud cdn_url[256];

93 _ud cdn_hdr[188];

94 _ug cdn_hdr_val[lee];
ﬂ’: /* file flags */

97 _i32 flags;

98

99 /* file name */

4. File: simplelink_extlib\ota\CdnClient.c. Changethe ReadFileHeaders declarationas
below. For every access to exosite server “access key” needs to be provided. The
below additional parameters are for that
L i32 OpenStorageFile{CdnClient t *pCdnClient, u8 *Tile name, 132 file size, w32 *ulTeoken, 132 *1FileHandle);

_132 ReadFileHeaders(_il6é fileSockId, _uB *domian_name, _u8 *file_name,_ u8 *hdr, _u8 *hdr_val);
v_132 RecvFileChunk(_ 116 Tilesockld, void ~pbut, 132 Len, _13Z Tlags);

5. File: simplelink_extlib\ota\CdnClient.c. Change the size of req_uri as below. This
increase of size is to accommodate longer path on the server
_i32 CdnClient_Cannect[ByUrl(\mid *pvCdnClient, OtaFileMetadata_t *pResourceMetadata, _i32 secured_connection)

{
CdnClient_t *pCdnClient = (CdnClient_t *)pvCdnClient;
_uB domain_name[64];

1 us req uri|alZ|; |
_ud Fcdn_url = pRescurceMetadata-»cdn_url;

6. File: simplelink_extlib\ota\CdnClient.c. Invocation of ReadFileHeaders inside
CdnClient_ConnectByUrlneedsto be changed as below. For every access to exosite
server “access key” needsto be provided. The below additional parameters are for
that.

/* read file headers, skip all not relenant readers */
status = _REadFilEHeaHer‘s(pCdnClientf)fileSocKId, pCdnClient->cdn_server_name, req_uril,pResourc:Metada:af)cdn_hdr‘)pResour‘cer"etadataf)cdn_hdr‘_\/aliJ
if (status < @)
Report("CdnClient_ConnectByUrl: ERROR, _FReadFileHeaders, status=%ld\rin", stztus);
CdnClient_CleseServer(pvCdnClient);
return CDN_STATUS_ERROR_READ HDRS;
}
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7. File: simplelink_extlib\ota\CdnClient.c. Change _ReadFileHeaders as below. For
every access to exosite server “access key” needsto be provided. The below
additional parameters are for that.

_132 _ReadFileHeaders(_il6 fileSockId, _uB *domian_name, _u8 *file_namel u8 *hdr, _us8 *hdr_wval

{

_132 status=8;
_132 len;
_uB *send buf = http send buf();

Report(” ReadFileHeaders: domain=%¥s, file=¥s\rin", domian_name, file name);

| http build request (send_buf, “"GET ", domian_name, NULL, file name,|hdr, hdr_vall);

8. File: simplelink_extlib\ota\OtaApp.c. Remove invocation of
LogClient_ConnectAndPrintinside sl_extLib_OtaRun. To enableloggingonthe
exosite server the LogClient_ConnectAndPrint APl needs to be changed. As

currently this not updated this invocation should be commented out.
Report(”sl extLib OtaRun: -------- end of updates\rin");

WriteStatFile ug *)pOtafpp->pStatistics, sizeof(g Otalpp statistics));
/fLogClient_ConnectAndPrint(pOtaApp-»pvLogClient, pOtaApp-:pOtaServerInfo, pOtaApp-»vendorStr, pOtaApp-»pStatistics); I

status = RUN_STAT_DOWNLOAD DONE;
return status;

9. File: simplelink_extlib\ota\OtaApp.c. Add below lines to the state
OTA_STATE_RESOURCE_LIST inside sl_extLib_OtaRun. For every access to exosite
server “access key” needsto be provided. The below additional parameters are for
that.

pltatnn-snBesourceMetadata-»sflash file size = pOtafnn-sfile sizes J/* 111 +he oply nacameter
stropy(plOtafpp->pResourceMetadata-»cdn_hdr, pOtalpp-»pltasServerInfo->rest_hdr);
strcpy(plOtafpp->pResourceMetadata->cdn_hdr_val,pOtafpp->pOtaserverInfo-»rest_hdr_wval);

Dreak

10. File : simplelink_extlib\ota\OtaApp.h. Change size of parameter vendorStrinside
the structures OtaApp_tand OtaApp_statistics_t as below. Thisincrease in size is to
match the vendor string modified for the exosite application.
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“typedef struct
1
_ua vendur5t1[1aa];
_i32 startCount,
_132 continucusAccessErrorCount;
typedef struct
1
OtaState_e state;
_132 runMode;
_u8 wvendorstg[186];
11. File simplelink_extlib\ota\OtaClient.c. Add below lines to
OtaClient_ResourceMetadata. Ensure that EXOSITE_OTA_SERVER is defined. As
http_build_requestis not compatible with exosite server these parameters are
explicitly set.
#ifdef TI_OTA SERVER
bhitp build ceguest (=end buf “OFT pOtasecyverTnfo_ssecyver domain, oOtasscysclnfo-»rest rsrc_metadata, NUI
gelif EXOSITE_OTA_SERVER
strepy((char *)pMetadata->cdn_url, (char const *)"http://");
strcat((char *)pMetadata->cdn_url, (char const *)pOtaServerInfo-rserver_domain);
streat((char *)pMetadata->cdn_url, (char const *)"/provision/download?");
strcat((char *)pMetadata->cdn_url, (char const *)pOtaClient->pVendorstr);
strecat((char *)pMetadata->cdn_url, "&id=");
strecat((char *)pMetadata->cdn_url, (char const *)resource_file name);
return OTA_STATUS OK;
E1sE
http_build request (send_buf, "POST ", pOtaServerInfo->server_domain, pOtaServerInfo-»rest_rsrc_metadata, re:
#endif
12. File simplelink_extlib\ota\OtaClient.c. Add below lines to OtaClient_UpdateCheck.
Ensurethat EXOSITE_OTA_SERVER is defined. This is to invoke specific parsing
needed for exosite.
#ifdef TI_OTA_SERVER
i pumlipdates = json nacse | ) len);
#elif EXOSITE_OTA SERVER
numUpdates = http_parse_exosite_update_check resp(pOtaClient, pOtaClient-»pOtaCheckUpdateResponse->rsrclist, response_buf, len);
numUpdates = json_parse_dropbox_metadata(pOtaClient->serverSockId, pOtaClient-»pOtaCheckUpdateResponse-»rsrclist, response_buf, len);
i #endif
13. File simplelink_extlib\ota\OtaClient.c.: Add belowlinesinside

OtaClient_ResourceNameConvert. Ensure that EXOSITE_OTA_SERVERis defined.
Thisis to support specific parsing needed for exosite.
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. 432 file flags;
' emp_str H
3 pMetadata-»p_file_name = &pMetadata->rsrc_file_name[l@]; /* space for prefix */
P strcpy( (char *)pMetadata->p_file_name, (const char *)resource_file_name);

/* Add metadata info (remowe it after serwver complete) */
3 pMetadata->p_cert_filename = NULL;
1 pMetadata->p_signature = NULL;
¥ pMetadata-»>flags = @8;

| #ifndef EXOSITE_OTA_SERVER |

¥ 7T Skip wendor string - as directory in the file name */
3 if (potaClient-:pVendorstr)

H

3 pMetadata-»p_file name = &pMetadata-»p_file_name[strlen((const char *)pOtaClient-»pVendorStr)+l]; /* skip "/
' h
3
)
) if (pMetadata-»p_file_name[1] != "f'} /* must start with 'f"' flags */
L Report(“0OtaClient_RescurceMetadata: ignore file name: ¥s, without f prefix\r\n", pMetadata-:p_file name);
i return OTA STATUS_ERROR;
1
#else

strcpy( (char *)temp_str,(char *)pMetadata->p_file name);

strepy((char *)&pMetadata-»p_file_name[1],(char *)temp_str);
pMetadata->p_file_name[@] = '/';

if (pMetadata-»p_file_name[1] != "f') /* must start with 'f" flags */

Report(“"OtaClient ResourceMetadata: ignore file name: %s, without f prefix\rin™, pMetadata-»p_file name);
return OTA STATUS_ERROR;

#endif

14. File simplelink_extlib\ota\OtaHttp.c: Add the below routine
http_parse_exosite_update_check_resp. Thisis to support specific parsingneeded
for exosite.
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-y
_332 (el s e Y e e T ) OtaClient_t *pOtaClient, RsrcData_t *pRsrcData, _u8 *read_buf, _i32 size)

{

h

_ug fileNumber=@;

_ug Ndx;

_ud *pBuf;

_ud *pBufil;

_i32 len;

RsrcData_t currentFile;

OtalptServerInfo_t *pOtaServerInfe = pOtaClient-:pQtaServerInfo;

ff Skip headers
béuf = (_uB *)strstr({(char *)read_buf,"\r\n\rin") + 4;
pBufl = (_ud *)strstr((char *)pBuf,”\rn");

while(NULL != pBufl)

memset(&currentFile,@,sizeof (RsrcData_t));
strncpy((char *)currentfFile.filename, (char *)pBuf,pBufl-pBuf);

pBuf
pBufl

pBufl + 2;
(_u8 *)strstr((char *)pBuf,”\rin");

pRsrclata[fileNumber+4] = currentFile;

for(Ndx=8; Ndx < fileNumber; Ndx++)
{
memset(send_buf,@,HTTP_SEND_BUF_LEN);
memset(read_buf,@,HTTP_RECV_BUF_LEN);
http_build_request (send_buf, "GET ",
poOtaServerInfo->server_domain,
potaServerInfo-:rest_rsrc_metadata ,
pRsrcData[Ndx].filename,
pOtaServerInfo-:rest_hdr,
pOtaServerInfo->rest_hdr_val);

len = s1_Send(pOtaClient-:serverSockId, send_buf, (_ile)strlen((const char

len = s1_Recv_eagain(pOtaClient->serversockId,
read_buf, HTTP_RECV BUF_LEN,
@, MAX_EAGAIN RETRIES);
if(len <= @ )
return OTA_STATUS_ERROR;

pBuf = read_buf;

*)send_buf), @);

pBuf = (_u8 *)strstr({const char *)pBuf, "‘r\n\r\n"}); /% skip HTTP response header */

if (pBuf == NULL)
return OTA_STATUS_ERROR;

pBuf = (_uB *)strstr({const char *)pBuf, ",");
if (pBuf == NULL)
return OTA_STATUS_ERROR;
pBuf += 1;
len = strstr((const char *)pBuf, ",") - (char *)pBuf;
if (len <= @)
return OTA_STATUS_ERROR;

pRsrcData[Ndx].size = strtoul((char const *)pBuf,NULL,18);

return fileNumber;
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15. File simplelink_extlib\ota\OtaHttp.h : Add the declaration for
http_parse_exosite_update_check_resp

_i32 json_parse_update_check_resp(_il6 sockId, RsrcData_t *pRsrcData, _ud *read_buf, _i32 size);

I_i32 http parse exosite update check resp(OtaClient t *pOtaClient, RsrecData t *pRsrcData, u8 *read buf, 132 size); I
_132 json_parse_exosite_metadata_url(_us *media_response_but, OtaFileMetadata_t *pMetadata);

7 Limitations/Known Issues

1. OTA cannot update an image to a newer image of same name if the size of the
newer image is larger than the max size allocated to that image.
2. File revert is only supported for MCU image file.
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8 Appendix

8.1 Detailed Representation of the OTA flow

Followed diagrams could be referred to in conjunction with Section-3

8.1.1 OTA Application State Machine

— _\_\-"‘\
C IDE -
— _ “  OtaRun/
o ’F‘I Connect server
| A
OtaSet commited \ |
or MCU reset \ //~—~t —
| \ Error AR
or TO _SE'WER__«//
{ \ r—
| I RS T A
| ListEmpty )
— T or TO
O wait Ty \ /
 HOST_CONFIRM \ OtaRuny/
x AN OtaClient_UpdateCheck
§ ™, s
\
\ AN
OtaRun, end of resources/ L =
DOWNLOAD_DOWE | — { RESOLRCE \\ _
o LIsT _F//_ OtaRun/
/-" OtaClient_GetNextUpdate
e OtaClient_ResourceMetadata
OtaRun, Status Done |
'l[ /—— L‘—-,_
/ )
. (" METADATA )
e Ny oy
s & L - -
/ //’ ~. |
/ { DOWNLOADING ) OtaRun /
DitaRun, Status continue / \“w-_ - CdnClient_ConnectByUrl
<dnClient_Run S a
o S o
T OtaRun / (

CdnClient_SetFilelnfa ™

CdnClient_Run

CONNECT
CON )

* CDN is also implemented in steps

* use same connection if

same CDN

* file name contains flags if to reset MCU/NWP

Figure 13 : OTA Application State Machine
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8.1.2 Sequence Diagrams

OTA client/server sequence

. . CDN OTA
MCIILI DTAI:app OTA Tllent CDN i::llent e =
Connect AP [ ]

Run any MCLU application |
In parallel, periodically call OTA

| | I

Extlib_Otalnit__,, | | | |
|

Extib_OtaRun_p | | | |

|_C0nnem5-ewer,{ I | |

E)dllb O.,t}aRun ConnectServer (TCP secured}—,,.

| I_UpdateCheclc_..T EIT .I:l |

/ HTTP GET /update check {wd pll ver)—u

| |
Extlib DtaRun_,,l _1_—HTIF‘ r‘espunse list of ready re‘lmuroes—l
P _GetNextUpdate, |

| | Metadata_rh | | I
|
|

[l

! ——HTTP POST /metadata (filename)

I ] I
OTA Run in steps - HTTP response: CON file URL

sUpport none G5

|
| |
| Parse file name prefix | |
fAR sys filename.ext
| AA Flags is s for secured file, wi | |
| o signature/certificate, option | |
to store in external storage,
| | |
| |
|
1

flag to reset MCU/NWP

GOHHECICEHSEW&F ’l ConnectServer
(CDN file PRL) » - *

| | L HTTP GET file header

| Cdnclier'lll_ﬁtun 0

I I 'I_ReadChunk_,l

| _ | | Save chunk in FS | I |

| Cdr‘lClIEI‘It_RUI'I » ReadChunI':_.I

|

| | Save chunk in F3 |

L—Duwnluad r:It:lﬂta-—j

|_GetNextUpdate)

|

MNomore_____
«—OTA dune_|‘_ | |
| |
|

Activate COMMIT | |
process

e | O Ul —

Figure 13 : OTA client/server sequence
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OTA and MCU Commit sequence — Success

MCU MCU bootloader OTA FileCommit NWP
|

_ —=|_extLib_Otalnit—m*

1
—sl_exiLib_OtaRun——
4— CONTINUE — = ————~— 1 |

[[|—————sl_extLib_OtaRun r—| |
MDONE, MCU_F{EEET— - — _-— _1 |
|

|

|

|

|

|

] FileCommit_IlmageTest !
(IMAGE_TEST_RESET_MCU) | |
| | Sel ImgState TESTREADY |
|

|

|

|

|

|

"

in f=ys/mcubootinfo.bin

e — _RESET_MGL.I—l ————— S I — |
MCU reset itself [ |
K

|
|
imgState is TESTREADY so |
|

Set imgState TESTING

o .
New image Rur‘: netw t|mag& ‘
(testing) B >
- | initComplate, wlanConnected, IPv4_Acquired
& I I

- FileCommit_lmageCommit |

|

Ll |

imgState is TESTING

o | SetimgState NOTEST | |
|

|

T~ [ IMAGE_COMMITED) 1

~ —CONTINUE- —}- - — ~ == | _

1
- On MCUEZ{lesting) Tallure,

New im )
€ IEQE Reset the MCLI,
(commited) bootiaader will check that
|

imgStata is slill TESTING and
will rellback to old IMAGE

Figure 14 : OTA and MCU Commit sequence - success
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OTA and MCU Commit sequence — Rollback

MCU MCU bootloader OTA FileCommit NWP
| | | |

T —sl_ethib_DlaInil—b|

_Sl_IBJ(lLib_G‘tERUFI—h |
+ —CONTINUE—— - — -——- |
|

B sl_leleIt}_DtaFEun—ﬂ
DOMNE, MCU_RESET-— == - — — — - | |

T |
w FileCommit_ImageTest
I (IMAGE_TEST_RESET_MCU) _'1
| | Set imgState TESTREADY
in fsys/mcubootinfo.bin
e — —RESET_MCU-bL— ———_ | ——— ]
T
MCU reset itsalf | | |
imgState is TESTREADY so | |
Set imgState TESTING | |
,r Run new image
New image ot | |
1 —_— L
(testing) —T | |
Ly ——FrrorTimeout on WianConnect/|Pvd_Acquired

FileCommit_|ImageCommit
[IMAGE_NOT_COMMITED)

imgState is TESTING
Stay on TESTING

|
|
|
——HESET_MCU-1 _____ _i___—— ___ﬂ
I | | |
||".'113Llresetilself|- g | |
imgState still TESTING
_ | setimgState NOTEST | |
Old image Rollback to old image | |
(rollback) ———sl|_start i | o
i., I initComplete, wlianConnecled, IPvd_Acquired———
|
FileCommit_|lmageCommit
[IMAGE_COMMITED) | ImgSiate is] NOTEST
| | Mothing to do
——CONTINUE-—{— ———————— {- ———————— {

Figure 14 : OTA and MCU Commit sequence - rollback
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8.2 Generic Guidelines for Enabling OTA on CC3100/CC3200

This section list down the recommended order of flashing during production, using UniFlash
tool, to enable OTA on CC3100/CC3200 device(s):

1. Open UniFlash tool for CC3200/CC3100.
2. Go to File->New Configuration and press ok with following option

»» MNew Configuration Iﬁ

Target Setup
Connection: iCC3x Serial(UART) Interface v]
Board or Device:  SimpleLink Wifi CC3100,/CC3200 -

0] 4 ] ’ Cancel

3. Format the storage with “Secure” and “Alert” unchecked.

-

v» Format Options I. | =] |_ih1

Capacity
1MEBE -

| ok || cancel

4. Update the service pack.

5. Create a new file in the sessions file list using “Add File” option and rename it to
“[sys/mcuimgl.bin”.

6. Create a new file in the sessions file list using “Add File” option and rename it to
“/sys/mcubootinfo.bin”.
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7. Set the following options for different files in the session

Table 3 : UniFlash File Options

File URL Options
/sys/mcuimg.bin Application bootloader Erase, Update, Verify
/sys/mcuimgl.bin 1°*OTA Image Erase, Update, Verify
/sys/mcubootinfo.bin - Erase

Note: For “/sys/mcuimg.bin”, “/sys/mcuimgl.bin” or any other user file set the “MaxSize” to
maximum size that will ever be required. OTA will fail to download any image with the same name
and size greater that it’s max size set during first time creation via UniFlash.

8. Save the configuration file
9. Press “Program” to program the file onto the device storage.

Refer to
http://processors.wiki.ti.com/index.php/CC31xx %26 CC32xx UniFlash Quick Start Guide for
complete UniFlash quick start guide.
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8.3 Enabling ‘FAST BOOT’ optionin Application Bootloaderand OTA library

The OTA scheme described in this document uses a two-stage booting. At the first age
the ROM bootloader loads the ‘application bootloader’. The second stage starts with
application bootloader identifying the user application image to boot using boot info file
and finally loading and executing the image.

The ‘FAST BOOT’ option reduces the overall loading time of the application image
marked as ‘ACTIVE’ (refer to section “3.2.4 Application Image Selection and Rollback
Logic”).

The trade-off here is the application bootloader run time size which increases from 16KB
to 32KB when ‘FAST BOOT” is enabled. To work with this application bootloader the
user (or OTA) application needs to be re-compiled and linked to run from 0x2000_8000.

Note:

1. With this configuration applicationdoes not support the Factor default image.

2. The 32-KB of memory used by application bootloader can still be used by the user
application for read-write data section.

3. This option only improves the loading time of image when
OTAU_MCU_IMAGE_STATE equals IMG_STATUS_NOTEST. Otherwise, the
loading time remains unchanged.

For enabling FAST BOOT:

1. Generate ‘fast boot’ application bootloader.

2. Compile the ‘flc.a’ library for ‘FAST BOOT”’

3. Compile and link the application to the new flc.a and to run from 0x2000 8000
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8.3.1 Generating ‘FAST BOOT Application Bootloaderin IAR

e Open the application bootloader project in IAR

e From the workspace window, choose ‘Release Fastboot’ project
configuration as shown below

e Run a ‘rebuild’

e Output : application_bootloader.bin “cc3200-
sdk\example\application_bootloader\ewarm\Release_Fastboot\Exe”

3 bootmer - AR Eeiiea WS T — =

File Edit View Project TIStellaris Tools Window Help

D H@ &% B R o | ntkable AT XX X 1 I
‘Workspace x
IRElEﬂSE "] sBootInfo_t sBootInfo;:
Felease

main.c | filesystem.h | udma_if.c |udma_if.h | startup_ewarm.c | bootmgr.ic

Felease_Fasthoot £ o )
- /4 Board Initialization

main.c by

startup_ewarm.c * BoardInit();

udrna_if.c »

L@ (3 Cutput v
/4 Initizlize the DMA
£
UDMATnit();

] #ifdef FAST BOOT
blIsMwpStarted = false;
r #endif

A

/7 Default configuration

£

sBootInfo.uchectivelmy = IMG ACT_ FACTORY:
sBootInfo.ulImgStatus = IMG STATUS NOTEST:

Copyright © 2014, Texas Instruments Incorporated PAGE: 54/58

Features characteristic data and other information are subject to change.



H CC3200 SimpleLink™ Wi-Fi®

I$ TEXAS CC3200 Over-The-Air (OTA) Update Application Note
INSTRUMENTS
www.ti.com

8.3.2 Generating ‘FAST BOOT’ Application Bootloaderin CCS

Import the application bootloader project in CCS workspace

Right click the projectin Project Explorer to get the menu as shown below
Set ‘Release Fastboot’ as active build configuration.

Run a ‘rebuild’

Output : application_bootloader.bin is generated under “cc3200-
sdk\example\application_bootloader\ccs\Release Fastboot”

|+'+ CCS Edit - Labl Hell

File Edit View MNavigate Project Run  Scripts Window Help

iR KRR

L5 Project Explorer &3 = 0O [lg main.c 22 [c]OxeBl4
= <§D - 1#include "inc/hw_types.h"
[ —— pe— 2 #include "inc/hw_memmap.h"
4= - 1T New , perlib/prem.h”
> il Ind erlib/uart.h”
> = Re Add Files erlib/pin.h"
> = Reg
. [ be B Copy Ctrl+C  gMsg = "Hello World !™;
> E“i m Paste Ctrl+V
> [§ st 3¢ Delete Delete
[ ue Refactor »
bd {
12 bd Source 2
= m Move... r *pMsg;
s L
> = Labl_ Rename... F2 re the pin mux to bring cut uart lines */
> 5 ota_uj t (PIN_S55,PIN_MODE_3);
S otau Import Y &(PIN_57,PIN_MODE_3);
by Export..
the UARTA® peripheral clock®/
Show Build Settings... heralClkEnable(PRCM_UARTA®,PRCM_RUN_MODE_CLK);
Build Project re the UART baud rate and data format */
Clean Project gSetExpClk(UARTAB BASE,
Rebuild Proi PRCMPeripheralClockGet (PRCM_UARTA®),
ebui roject 115208,
&' Refresh F5 (UART_CONFIG_WLEN_E | UART_CONFIG_STOP_ONE |
Close Project UART_CONFIG_PAR_NONE));

rl'esage buffer */

Build Configurations 3 Manage...
Make Targets » Set Active b | ¥ 1Release

2
Index Build Al 2 Release_Fastboot
Debug As 3 Clean All
Team 3 Build Selected...
Compare With 4
Restore from Local History...

e loop */
Properties Alt+Enter
o T
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8.3.3 Generating ‘FAST BOOT’ Application Bootloaderin GCC

e In Cygwin, switch to ‘cc3200-sdk\example\application_bootloader\gcc’
directory

e Run “make -f Makefile_fastboot”

e Output : application bootloader.bin is generated under “cc3200-
sdk\example\application_bootloader\gcc\exe_fastboot”

8.3.4 Generating ‘FAST BOOT flc.a library

The steps for generating flc.a library is same as the for application bootloader. The flc .a
IARorCCS project file/ GCC Makefile can be found under the directoy “cc3200-
sdk\simplelink_extlib\flc” in the SDK installation.

8.3.5 Re-Compiling the applicationin CCS

e Import the ‘ota_update_nonos’ projectinto CCS workspace

e Expand the project to see the list of files

e Openti_rtos\ti_rtos_config\app.cfg and change as below:
Hwi.vectorTableAddress = 0x20008000;
Hwi.resetVectorAddress = 0x20008000;

e [Locate and open ‘cc3200v1p32.cmd’ file

e Do the following modification.

e Do arebuild

#define RAM_BASE 0x20008000
/* System memory map */

MEMORY

{
/* Application uses internal RAM for program and data */
SRAM_CODE (RWX) : origin = 0x20008000, length = ©x13000
SRAM_DATA (RWX) : origin = ©x2001B000, length = 0x11000

Copyright © 2014, Texas Instruments Incorporated PAGE: 56/58

Features characteristic data and other information are subject to change.



H CC3200 SimpleLink™ Wi-Fi®

I$ TEXAS CC3200 Over-The-Air (OTA) Update Application Note
INSTRUMENTS
www.ti.com

8.3.6 Re-Compiling the applicationin IAR

e Open ‘ota_update nonos’ project into IAR workspace

e C(Create a copy of the default linker file. Typical path “<IAR installation
root>\arm\config\linker\TexasInstruments\cc3200.icf

e Editthe linker script as shown below

define region SRAM
}

else

{
define region SRAM

}

mem: [from ©x20000000 to Ox2002FFFF];

mem: [from 0x20008000 to Ox2002FFFF];

e Open project option window, under linker, override the default ‘linker
configuration file’ to point to the newly edited linker script.(shown below)

e Do a ‘Rebuild All’

Options for node "ota_update_os” @

Categony: ’ Factory Settings l

General Options

Runtime Checking
C/C++ Compiler
Assembler Corfig | Liblaryl Input I Optimizations | Advanced I Output I List I o
Qutput Converter
Custom Build Linker configuration file
Bulld Actions Overide defaul
Linker
Debugger EPROJ_DIRS\cc3200_edited icf E]

Simulator
Anoel
CMSIS DAP
GOEB Server Configuration file symbol defintions: (one per line)

IAR ROM-manitor CC3200 ES_1.2 1=0 -
Iet/ITAGIEt

JLink/1-Trace

TI Stellaris
Macraigor

PE micro

RDI

ST-LINK
Third-Party Driver
XD5100/200/1C0T

(0] l ’ Cancel
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8.3.7 Re-Compiling the application in GCC

e Open linker scriptota_update_nonos.ld from ota_update_nonos/gcc
e Modify as shown below.
e Rebuild the application.

MEMORY
{

}

SRAM (rwx) : ORIGIN = 0x20008000, LENGTH = 0x00030000

8.3.8 FlashingImages

With ‘FAST BOOT” option enabled, the application bootloader uses a different
set of file name. The following table lists the changes

File File .

(w/o FAST BOOT) (w/ FAST BOOT) URL Options
/sys/mcuimg.bin /sys/mcutst.bin Application bootloader Erase, Update, Verify
/sys/mcuimgl.bin /sys/mcuimg.bin 1°'OTA Image Erase, Update, Verify
/sys/mcubootinfo.bin | /sys/mcureserved.bin - Erase
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